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Disclaimer 

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of 
this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets 
certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, 
defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All 
information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer 
to the License Agreement for important obligations and applicable limitations and restrictions on your rights. 
Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves 
the right to make changes and additions to this manual due to changes in the software or otherwise. 
 
In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized 
reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil 
and criminal penalties, and will be prosecuted to the full extent permitted by law. 
 
Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion and are either 
registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, 
and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla- trademarks. 
Trimble is a registered trademark or trademark of Trimble Navigation Limited in the European Union, in the 
United States and/or other countries. More about Trimble trademarks: 
http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or 
may be trademarks of their respective owners. By referring to a thirdparty product or brand, Trimble does not 
intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or 
endorsement, except where otherwise expressly stated. 
 
Portions of this software: 
D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved. 
EPM toolkit © 1995-2004 EPM Technology a.s., Oslo, Norway. All rights reserved. 
Open CASCADE Technology © 2001-2014 Open CASCADE SA. All rights reserved. 
FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved. 
Teigha © 2003-2014 Open Design Alliance. All rights reserved. 
PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved. 
FlexNet Copyright © 2014 Flexera Software LLC. All Rights Reserved. 
This product contains proprietary and confidential technology, information and creative 
works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, 
modification, or transmission of such technology in whole or in part in any form or by any means without the 
prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by 
Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or 
rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or  
otherwise. 
 
To see all the third party licenses, go to Tekla Structures, click Help --> About and click the Third party licenses 
button. 
 
The elements of the software described in this Manual are protected by several patents and possibly pending 
patent applications in the United Stated and/or other countries. For more information go to page 
http://www.tekla.com/tekla-patents. 
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1 Overview of Integration  

 
 
When considering the integration of Tekla Structural Designer and Tekla Structures it is important to understand 
that the information transferred is essentially the physical information associated with the structure - e.g. 
geometry, section sizes and grade, number of studs and slab thicknesses etc. 
Tekla Structures allows engineers to quickly and easily create accurate structural models complete with 
information that offer value from design to construction completion. Design data can be imported and enhanced 
with Tekla Structures for the production of complete, coordinated and constructible drawings and material lists. 

The integration process allows users to pass models to and from Tekla Structural Designer and Tekla Structures, 
updating changes to the physical model whilst also allowing both parties to concurrently update their own 
versions of the model. As the model is integrated between software applications, the user will find that changes 
are updated whilst additional items created since the last export operation are maintained within the model. 
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2 Project Workflows 

Integration between Tekla Structural Designer and Tekla Structures has been developed to ensure the initial 
model can be started in either tool without any detriment to the design process. This added flexibility enables 
companies to align their software solutions closely to their own workflows. (I.e. The initial model can be created 
in Tekla Structural Designer by the Engineer, or in Tekla Structures by the Technician.) 

We would recommend that the Tekla Structures model be used as the master model for all geometrical changes. 
Alterations made to the model geometry are best handled by altering the Tekla Structures model and transferring 
the changes through to Tekla Structural Designer for redesign. 

A typical workflow and the decision making process through the different stages of a project could be as follows:- 

2.1 Initial Scheme Stage 

 The initial model may be started in Tekla Structural Designer or Tekla Structures without any detriment to 
the process. 

 A number of factors may determine which software is used in the initial modelling process, such as 
availability of staff, or deliverable requirements. 

 Unless there are external drivers, Tekla Structures may prove to be the best starting point for the model 
as it can provide most of the deliverable items at the initial stage. 

 The model does not need to cover the complete building, it might be a typical bay or floor for example. 

 The generated structure can be designed in Tekla Structural Designer for initial section sizing at the initial 
stage and synchronized back to Tekla Structures for initial drawings or material list creation. 

 Simple drawings can be created at this stage; this can be done in Tekla Structural Designer or Tekla 
Structures. 

 Initial material lists for cost estimates can be generated at this stage. 

2.2 Detailed Design 

 It is not always appropriate to carry models forward from the Initial Scheme Stage to the Detailed Design 
Stage. It is sometimes better to begin the model again. 

 Models can be started in Tekla Structures or Tekla Structural Designer to suit the user. The models can 
then be transferred to the other modelling system. 

 Importantly, the two models can be worked on at the same time, with synchronization of the two models 
taking place to suit the workflow. 

 Within Tekla Structural Designer, the model can be used for a full design of the structure, sway check, 
lateral (wind) design and a design of connections (if required). 

 Within Tekla Structures, drawings can be generated to a Tender stage level and general arrangements 
submitted to Building Control for approval. 
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2.3 Construction Stage 

 Using the model from the Detailed Design stage, much of the Construction Stage process will take place in 
Tekla Structures so that the integration with other trades can be accounted for. 

 The design is not revisited unless the client drives the requirement for change. 

 If a re-design of the structure is required, the same synchronization of Tekla Structural Designer and Tekla 
Structures models can be carried out to suit the user. 

 The model will be completed within Tekla Structures and fully detailed drawings for parts can be created 
along with construction level drawings of the structure. 

 Detail integration checks with other trades (e.g. Mechanical and Electrical Engineers) can be carried out at 
this stage. 
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3 Tekla Structural Designer into Tekla Structures 

3.1 Creation of the Tekla Structural Designer Model 

The Engineer has a number of options available to him when creating a Tekla Structural Designer model. 

3.1.1 Create model from Scratch.  

 Tekla Structural Designer includes typical modelling tools to create grids, columns, beams, walls, floors 
etc. Importantly each element is modelled as a physical object that can be positioned correctly in space.  

 When synchronised with Tekla Structures, the true spacial position is communicated along with items 
such as sections size, grade, studs, holes etc. 

 For a full list of communicated items, see Section 7.  

 

3.1.2 Part Models. 

 At the early stages of design, it is possible to create part models to investigate a structural scheme.  

 For example, the engineer can model just a floor or a bay in Tekla Structural Designer to investigate the 
best solution to satisfy code compliance and economics.  

 Although only a part model, this can still be sent to Tekla Structures. (Note, the physical position of the 
part model will be communicated to Tekla Structures.)  

 For example, if an engineer models a floor but the true level is not yet known, this part model can be sent 
to Tekla Structures where adjustments can be made. If this model is communicated back to Tekla 
Structural Designer its position will be updated.  

 At the early design stages is it reasonable to stop the bi-directional integration as new refined models are 
often created later in the design process.  

 

3.1.3 Import 2D Drawings.  

 It is common early in a project to have a number of 2D architectural drawings outlining the scheme. Tekla 
Structural Designer has the facility to import 2D DXF drawings.  

 The engineer can use these drawings as ghost layouts in the background to aid setting out or to import 
grids.  

 If a common grid is used on the project, it is logical to import this grid into Tekla Structural Designer to 
ensure the structure is set out in the correct position. 

 If a number of separate models are to be created and merged together it is strongly advisable to use a 
common grid system. 

 When importing grids it is also advisable to check the geometry of the grid thoroughly. 
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3.2 Deliverables 

Even at these early stages of a project, Tekla Structural Designer provides a significant number of the deliverables 
required. 

For example:-  

 Comprehensive code compliant scheme design. 

 Material take off. 

 2D engineering DXF drawings. 

 Member end forces and support reactions. 

 

3.3 Exporting a model from Tekla Structural Designer 

Once a model has been created in Tekla Structural Designer, you need to save the model with a recognisable 
name and then run the command Tekla Structures Export. 
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Running the command will start the export application with various dialogs displayed through a wizard process. 
The first screen encountered will allow you to move the model to a real world co-ordinate by entering suitable 
figures within the dialog. In our case, we will keep the values at the default and just choose Next. 

 

After the model location, you will be prompted to choose the element types to choose to export along with 
options for openings where applicable. The default settings are that all items should be exported and in this 
example, we will follow the same settings – clicking Next to continue. 
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In this example, we have chosen to export Analysis Results as the model has been successfully analyzed and 
designed within Tekla Structural Designer. This option (deselected as default) directs us to a new dialog where we 
can choose which analysis methods, loadcase results and load combination results we can choose to export. We 
keep the default setting of first order linear analysis results for all combinations and simply click on the Next 
button to advance. 

 

Mapping of materials to recognised grades will be then shown. Here you can view the different materials being 
used in the Tekla Structural Designer model and the option to overwrite the exported materials with a more 
preferred grade. 
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Following on from Material mapping, the dialog for Decking mapping will be shown (if applicable). Again, this 
allows users to view the decking types being used in the model and have the option of overwriting the exported 
details if required. 

 

The final dialog screen of the export wizard will prompt for a filename and location of the CXL file to be created. 
Please note that there are two options relating to a first time export and an option to update and existing model. 
For the initial export, the option First Time Export should be chosen. (The option to Update Existing Model will 
be used to pass alterations in the event of a Tekla Structures model already in existence.) 
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3.4 Importing a model from Tekla Structural Designer into Tekla Structures 

This example covers the import of a model into Tekla Structures. The file that we are using contains no mapping 
problems (section sizes not being automatically recognised by the integration process) and reference should be 
made to section 6.1 if you find that your own files do contain problems regarding unrecognised sections.  

This example is going to follow a first time import into Tekla Structures from Tekla Structural Designer so initially 
we start with a new Tekla Structures model. 

 

To import a model we need to use the command Import - Tekla Structural Designer which is available from the 
software File menu. 
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When the Import From Tekla Structural Designer command dialog appears, the first step should be to select the 
CXL file to be imported into the model. This can be done by clicking on the … button to the top right and browsing 
to the file with a simple windows dialog. 

 

Once the file has been selected, the next stage should be to check the mapping of members between the 
software packages. This can be done by clicking on the Preview Conversions command. 
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The Preview Conversions button will allow you to check sections being imported from Tekla Structural Designer 
and flag any unrecognised profile names within the Tekla Structures software easily. Refer to the later section 
regarding conversion files for assistance if this is required. 

 

There are two options held towards the bottom of the dialog which are related to grid patterns. In this example 
we will keep both of the options enabled so that the existing grids are deleted from the Tekla Structures model 
and instead a grid pattern generated from the Tekla Structural Designer export is used instead. 
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The final options relate to the import of the model itself. The Import at Origin option will create the model based 
on the 0,0,0 position within Tekla Structures whilst the Import at Location option will allow the user to specify a 
position to base the model upon. 

In our example we will use the default datum position and so use the option Import at Origin. 

 

The file will then process and quickly show the imported model. At this point, any open dialog windows can be 
closed down and the imported model inspected. 
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4 Tekla Structures into Tekla Structural Designer 

4.1 The Tekla Structures Model 

When the design process is started in Tekla Structures, there are a number of considerations to be made:- 

 

 
A Tekla Structures model can be exported to Tekla Structural 
Designer in part or in full. 
. 

 

 

 

 
To export a part model, first select the members you wish to 
export, prior to creating the export file. The use of Tekla Structures 
view filters or selection filters can help with the selection of objects. 
 

 

 

 
Only the main structural elements to be designed should be 
exported. 
 

 

 
 

 

 
Part elements that are not structurally significant (such as 
endplates, cleats, gusset plates, handrails, ladders etc.) should not 
be exported. Remove these items from the view display (or from 
the selection criteria) and choose to export selected model parts 
only. 
 

 

 

 

 
Tekla Structure part grip points should all intersect at the same 
location so that the resulting Tekla Structural Designer model is fully 
connected. 
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4.2 Exporting a model from Tekla Structures to Tekla Structural Designer 

This example covers the export of a completed Tekla Structures model into CXL format. The CXL file can then be 
imported into Tekla Structural Designer. 

The file that we are using contains no mapping problems and reference should be made to the relevant help 
documentation should you find that your own model does contain problems regarding mapping. 
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To export the model to Tekla Structural Designer, access the command Export - Tekla Structural Designer from 
the File menu dropdown. 
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The main Export To Tekla Structural Designer dialog should now appear. The first step that should be completed 
is to set the Export file name and location. Here we have chosen to call the exported file New Model 1.cxl. 

 

After setting the export filename, you can choose to preview the conversion process to check if there will be any 
mapping problems encountered. If members have been selected prior to running the export command, then the 
Export Selected option can be used. In our case though, we will use the Export Model command to transfer the 
entire model. 
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After the file has finished processing, a list of statistics should be displayed showing the amount of members, 
panels and walls which have been exported along with any warnings and errors which have been encountered. 

The export dialog can then be closed along with the dialog and the resulting CXL file can be transferred to the 
Tekla Structural Designer user. 
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4.3 Initial Import into Tekla Structural Designer 

To import a model into Tekla Structural Designer from Tekla Structures, we need to use the command Structural 
BIM Import which is held on the Home tab. 

 

Clicking on the command will launch the import application which shows several dialogs in a wizard process. The 
first one to be encountered will prompt for the CXL filename and location which is to be integrated. Use the … 
button to browse and select the appropriate CXL file. 
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After selecting a CXL file for import, you should find that the remainder of the fields are populated with the 
settings read directly from the file. Click Next to continue after reading the information. 

 

The next screen shows the settings related to the file allowing the user to choose Metric or Imperial for the units, 
a design code and the default level type. The level type can later be adjusted in the construction levels dialog if 
required.  

Please note that the Update Existing Model option should not be used as this time. For changes to existing Tekla 
Structural Designer models, please refer to Section 5. 
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The Relocate Import Model dialog allows for models to be moved to around the datum position in Tekla 
Structural Designer from a real world co-ordinate. The extent of the model can be seen from the information 
displayed on the right hand side of the dialog. After entering suitable values, click Next to continue. 
 

 
 
Following on from the position information, the integration filter will be displayed. The five options shown here 
allow you to verify if grids, levels etc. are to be imported. 
 
Please note that the settings held in the Delete Existing… and four Update… columns should not be used when 
performing a First Time Import and are only used when synchronizing changes into an existing Tekla Structural 
Designer model. 
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Mapping of materials to recognised grades will be shown now. Here you can view the different materials 
recognised in the incoming CXL file and the options to alter materials with a more preferred grade. 
 

 

Following on from Material mapping, the dialog for Decking mapping will be shown (if applicable). Again this 
allows users to view the decking types being imported and have the option of overwriting the details if required.  

After setting this information, click Finish to start the import into Tekla Structural Designer. 
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After the file has completed processing, the model will be displayed within the Structural 3D view and you can 
then proceed with validation of the structure before applying any analytical information. 
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5 Synchronizing Models 

After an initial import has taken place it is typical for both the Tekla Structural Designer and Tekla Structures 
models to be developed independently.  

However as the project and design of the structural frame is refined, it is appropriate to synchronize the models 
together to communicate any changes in geometry, section size, and design parameters. This is easily achieved by 
repeating the import procedures. 

5.1 Synchronizing Tekla Structures to Tekla Structural Designer  

5.1.1 Export from Tekla Structures 

In Tekla Structures save the model with a recognizable name and then use the command, Export - Tekla 
Structural Designer - Export to… to create a new .cxl file. It is recommended that you give this new .cxl file a 
name that indicates the integration sequence (i.e. Pass2.cxl). Note the details of the log file and check they match 
the user's expectations.  

Tip: If objects are selected prior to initializing the export, use the option Export Selected rather than Export 
Model. 

5.1.2 Import into Tekla Structural Designer 

With your current Tekla Structural Designer model open, you should first save your model to retain a copy of the 
pre-import status, should it be needed in the future. Then repeat the command Structural BIM Import which is 
held on the Home tab. 
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Clicking on the command will launch the import application which shows several dialogs in a wizard process. The 
first one to be encountered will prompt for the CXL filename and location which is to be integrated. Use the … 
button to browse and select the appropriate CXL file. 
 

 

After selecting a CXL file for import, you should find that the remainder of the fields are populated with the 
settings read directly from the file. Click Next to continue after reading the information. 
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The next screen shows the settings related to the file allowing the user to choose Metric or Imperial for the units, 
a design code and the default level type. The level type can later be adjusted in the construction levels dialog if 
required. 

The Update Existing Model option should now be used as we are importing changes to an existing Tekla 
Structural Designer model. 

 

Use the exact same settings on the Relocate Import Model dialog as were used when previously importing the 
model into Tekla Structural Designer. If the model originated in Tekla Structural Designer, keep all values at 0 and 
click Next to continue. 
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Following on from the position information, the integration filter will be displayed. The five options shown here 
allow you to verify if grids, levels etc. are to be imported. 

You should also determine whether the five additional options are appropriate to the synchronization that you 
are performing. All of the options in this dialog can be described as follows: 

5.1.3 Include (enabled as default) 

 Simply controls whether objects of this type are considered by the Import, (added, modified or deleted if 
checked) or left as currently defined in the existing model, (not checked). 

5.1.4 Delete Existing if not in Import File (enabled as default) 

 If enabled, then an object in the existing model that is not in the import file (most likely already deleted in 
Tekla Structures) will be deleted from the Tekla Structural Designer model. 

 If you are unsure and wish to double check, uncheck the box and you will find the member retained for 
manual deletion at a later date. 

 There are exceptions, depending on the object’s BIM Status – see special Review mode. If the status is 
New or Excluded, then the object will not be deleted during the update process whether this option is 
checked or not. 

5.1.5 Grids 

 Update Position affects the start and / or end of a grid line. Note: Currently arc grids cannot be 
synchronised. 

 Update Other Data affects changes made to the grid name only. 

5.1.6 Levels (Construction Level) 

 Update Position affects any changes made to the level height within Tekla Structures. 

 Update Other Data changes the name of the level to suit the Tekla Structures model. 

5.1.7 Slabs / Deck (Slab Items) 

 Update Section / Grade updates any alterations made to Slab Depth, Concrete Grade or Decking 
Properties (if relevant). 

 Update Position makes changes to the outline of the slab, alignment (vertical offset) and plan rotation. 

 Update Openings adds, removes or modifies the outline for openings associated with the slab item. 

 Update Other Data will alter the type of slab if amended in Tekla Structures. 
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5.1.8 Members (Columns, Beams, Braces etc.) 

 Update Section / Grade will update and changes made to the section size or the material grade. 

 Update Position changes the member to suit alterations made to the start and / or end of the physical 
member, alignment or rotation in section. 

 Update Openings adds, removes or modifies the outline for openings associated with the member. 

 Update Other Data will change any other characteristics such as the gravity only flag and end release 
conditions. 

5.1.9 Walls (Concrete and Bearing) 

 Update Section / Grade controls any updates to the wall thickness and material grade. 

 Update Position changes the wall to suit amendments made to the start and / or end of the physical wall 
along with changes made to the alignment. 

 Update Openings adds, removes or modifies the outline for openings associated with the wall. 

 Update Other Data affects the ‘Use mid pier’ option (Note: for concrete walls only) 

 

  



5 Synchronizing Models 32 (50) 

 

Guidance Documentation Tekla Structural Designer 
© Trimble Solutions Corporation | [Date] Integration with Tekla Structures 

 

Mapping of materials to recognised grades will be shown now. Here you can view the different materials 
recognised in the incoming CXL file and the options to alter materials with a more preferred grade. 

 

Following on from Material mapping, the dialog for Decking mapping will be shown (if applicable). Again this 
allows users to view the decking types being imported and have the option of overwriting the details if required.  

After setting this information, click Finish to start the import into Tekla Structural Designer. 
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5.2 Integration management in Tekla Structural Designer     

Once the synchronization process has been completed, the command BIM Status (held under the Review tab) can 
be used to provide a colour coded indication of how the model has been affected in the last import. This view 
identifies all the changes to Tekla Structural Designer members and slabs which have occurred as a result of 
merge process. 

 

Color coding Description  

 New 
Object has been created in Tekla Structural Designer and has not yet been 
exported to Tekla Structures. 

 Imported 
Object has been created by the import from Tekla Structures. 

 Exported 
Object has been previously exported to Tekla Structures (prior to any 
import processes). 

 Updated 
Member has been modified as a result of the Structural BIM import. Check 
the BIM status tree for details. 

 Deleted 
Object has been deleted in Tekla Structures but has been retained during 
the merge process due to the Integration Filter settings. 

 Mixed Work in progress – Has no effect as yet. 

 Excluded 
Item will not be communicated from Tekla Structural Designer to Tekla 
Structures. 

 Not Modified Object has not been altered in any way by the Structural BIM Import 
process. 

 
New indicates members that have not been communicated to Tekla Structures yet. As Tekla Structures should 
hold the master physical model it is advisable to first export the Tekla Structural Designer to Tekla Structures and 
then perform the merge again with the updated Tekla Structures model. 
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5.3 Synchronizing Tekla Structural Designer to Tekla Structures 

5.3.1 Export from Tekla Structural Designer 

To send the changes made in the Tekla Structural Designer model to Tekla Structures, the export procedure is 
repeated using the command Export to Tekla Structures which is held on the Home tab. 

During the export process it is recommended that you give this new .cxl file a name that indicates the integration 
sequence (i.e. Pass3.cxl). 

5.3.2 Synchronizing a model from Tekla Structural Designer to Tekla 

This example covers the import of a second (updated) CXL file into Tekla Structures. The file that we are using 
contains no mapping problems and reference should be made to the relevant sections in this document should 
you find that your own file does have any problems regarding mapping.  

Firstly, with the current Tekla model open in the background, start the integration process by running the 
command Import - Tekla Structural Designer 
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When the Import From Tekla Structural Designer dialog appears the first step should be to select the CXL file to 
be imported into the model. This can be done by clicking on the … button to the top right of the dialog and then 
browsing to the file with a simple windows dialog operation. 

 

The Preview Conversions button will allow you to check section sizes being imported from Tekla Structural 
Designer and flag any unrecognised profile names within the Tekla Structures software easily. Unrecognised 
sections being listed in red type within the quick report window. Please refer to the later section in this manual 
for help with on creating conversion files and mapping part names if this is required. 

 

  



5 Synchronizing Models 36 (50) 

 

Guidance Documentation Tekla Structural Designer 
© Trimble Solutions Corporation | [Date] Integration with Tekla Structures 

 

Two options are located at the bottom of the dialog relating to the position of the imported model. The Import at 
Origin option will create the model based on the 0,0,0 position within Tekla Structures whilst the Import at 
Location option will allow the user to specify a position to base the model upon. 

As this example is an update to an existing model it is important to ensure that the same location is used to for 
the update as was used for the initial model import. The original model import was created using the Import at 
Origin option so we will use the exact same option for the update file. 

 

As items in the import file have previously been imported into Tekla Structures, the Model Comparison Tool 
dialog is shown. This dialog shows all parts which are flagged as New, Updated, Deleted or Unchanged. In our 
example, we see that we have 23 Updated Parts along with 317 Unchanged (0 New and 0 Deleted). 
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Although there is no information which needs to be amended on the Unchanged tab, it is worth reviewing the 
information listed in the Updated tab. Each of the sections are listed along with a red highlight in the data 
window indicating the property field which has been amended, the original value and the new proposed value.  

Each value can be either ignored or updated to suit. 

Click Accept to update all of the information alterations and exit the dialog. The model will then process the 
changes and show the updated model on the screen. At this stage, the Import from Tekla Structural Designer 
dialog window can be closed entirely. 

 

It is possible to view the changes in the model using the TSD_Integration Status Updated display representation. 

Views using this representation will indicate colored parts according to their integration status. 

Double click on the view background to access the View Properties dialog, set the TSD_Integration Status 
Updated representation and then click on the Modify button. 
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The resulting view will then be coloured so the integration status is easily identifiable. 
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6 Key Rules 

Some key rules to consider when integrating models :- 

 Communication between both parties is crucial to ensure the sharing of data is as expected during model 
synchronization. It is particularly important that both parties are aware of significant changes and can 
verify them on completion of the integration process. 

 Before exporting/importing models, always save the models with names that make it clear as to which 
step they represent. This permits the users of both Tekla Structural Designer and Tekla Structures to 
return to a given point should the need arise. 

 If necessary, changes in the level of a floor are best made manually in Tekla Structural Designer before 
merging a model from Tekla Structures. The benefit of doing this is that only changes with the moved 
floor will be identified in the process. If the floor was not moved in Tekla Structural Designer, then the 
merge process would move the floor and identify all members in the floor and columns supporting the 
floor as having changed. This is far less informative than the alternative. 

 Items are linked between the two products by using identification tags. Obviously if something is deleted 
and replaced, the new member cannot retain the tag and hence any relationship with what was there 
previously is lost. 

 Should the same members be added to both the Tekla Structural Designer and Tekla models 
independently and then models merged, these members will be duplicated as the new member from one 
will be added on top of the new member in the other.  

 Items which are not usually required in Tekla Structural Designer (such as concrete works or ancillary 
items like ladders, handrails, rails etc.) should not be exported to Tekla Structural Designer. This can be 
performed by hiding the unrequired items in the Tekla view or by the use of selection filters. Select the 
remaining model and then run the export command using the option Export Selected. 
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6.1 Mapping Sections between Tekla Structural Designer and Tekla Structures 

After clicking on the Preview Conversions button, it may be found that one or more profile names or material 
grades cannot be mapped to an equivalent reference in either Tekla Structural Designer or Tekla Structures. 

The link uses an internal conversion list contains the standard profiles and grades. Any item that cannot be 
translated using this internal conversion will be flagged in red and listed as having no available match. 

E.g. ULT-RBM-1706316   *** NO MATCH *** 

 

In the example above as we have both profiles and materials being listed, we would need to create two 
conversion files. The files themselves are simply text files which can be created with any text editor such as 
Notepad or WordPad. The files do not need any information to be entered apart from the actual conversion 
itself. 

The conversion format MUST be written in the format Tekla Structural Designer profile name=Tekla profile 
name. eg:  

STB 229x305x70=TEE229*305*70 
Or in our case 
ULT-BEAM-1705016=ULT-RBM-1706316 

It is possible to provide conversion for Tekla Structural Designer twin profile sections to and from Tekla 
Structures. The UK twin profiles in Tekla Structural Designer have a fixed gap and have been added to the 
automatic translations. For other countries, it is necessary to use the conversion file. The line is slightly different 
in that you need to include the gap in the line. 

The number after the # symbol is the profiles code in the cxl file format.  The code is different depending on the 
profile type, whether it is metric or imperial and what country is it from. Below are 3 different double angle 
profiles from Tekla Structural Designer. The first number represents whether the profile is metric or imperial: 0 
for metric, 1 for imperial. The next 2 digits represent the country in this case 06 for UK. The last 2 digits are for the 
profile type, 15 for long leg to long leg, 16 for short leg to short leg and 14 for equal angles. 
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The TS profile is the L shape to use for each of the two members Tekla Structures will create to represent the 
single item in Tekla Structural Designer. The number after the : is the gap to use between the profiles in Tekla 
Structures and the (LL) and (SL) convey the required orientation of the members. 
 
2xUEA(LL) 100x75x8#00615=RSA100*75*8:10(LL) 
2xUEA(SL) 75x100x8#00616=RSA100*75*8:12(SL) 
2xEA 120x120x10#00614=RSA120*120*10:12 
 
On export, using the same conversion file, the two members in Tekla Structures will be written to the cxl file as 
one twin profile member assuming it is still logical and possible to do so. 
 
The material conversion file would be similarly formatted with the Tekla Structural Designer profile name=Tekla 
profile name format. For example: 
 
S275=S235J2G3 
 
If the conversion files are not used, those members with profiles/materials that cannot be converted will still be 
created albeit with unrecognized section names. These members will be shown in Tekla Structures as a single line 
representation and within Tekla Structural Designer as a blank section size which will cause a validation error. 
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7 Generating efficient integration models 

7.1 Principals of integrating with Tekla Structures 

It is a requirement of Tekla Structural Designer to have a fully connected model so that analysis can be completed 
without any stability or validation issues. Engineers use an analytical wire model to mathematically predict how a 
building will behave under applied loads. The analytical wire model is derived automatically from the transferred 
physical model. 
       

 
 
In order to communicate a viable model for analysis, it is important to ensure that Tekla Structures part objects 
are modelled to correct positions. The position of any structural item in Tekla Structural Designer is based on the 
grip point location of the element in Tekla Structures.  
Therefore it is vital to ensure that parts are generated from common intersection positions when considering 
integration with Tekla Structural Designer. If parts are generated from physical locations then the resulting 
analysis and design model will not be analytically correct. 
 

 
      
Please note that connection macros can still be applied to parts defined to common grid or part locations. 
NB: Ensure that the connections themselves are not transferred (see later section). 
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7.2 Offset members and moved members 

Where members are to be located away from member intersection points or grid positions, please note that 
there is a significant difference between moving parts and assigning offset values onto parts. 

 Physically moving Tekla Structure parts also moves the grip points (which will potentially affecting frame 
connectivity when transferred into Tekla Structural Designer).  

 Applying offsets to parts properties will move the physical representation but keep the grip points in the 
original location.  

For integration with Tekla Structural Designer, we would recommend the preference of offsetting parts to ensure 
that model connectivity is maintained. 
 
 

7.3 What items are transferred? 

The default is that the export from Tekla Structures will export ALL parts, including connections and other 
ancillary items which cannot be designed in Tekla Structural Designer and are beyond the scope of the software. 
To ensure that these items are not transferred, use Object Group filters to disable the visibility of these items and 
then only export the remaining visible items. 
 

       
 
     

7.4 Construction levels 

7.4.1 Levels exported from Tekla Structural Designer 

When generating levels within Tekla Structural Designer, it is important to understand that not all levels will be 
transferred using the Integrator. 
 
For levels generated in Tekla Structural Designer, only levels which have been flagged as Floor items will be 
exported. The exception to this rule is the lowest most entry in the dialog which is always exported regardless of 
the Floor flag setting. 
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E.g. When looking at the example below, we find that four levels would be exported. Three of the levels are 
flagged as Floor whilst the lowest most level is always exported. 
 

 
 
 
 
For levels created on import into Tekla Structural Designer from Tekla Structures, levels will be generated where 
either: 

 A level has been exported from Tekla Structures (see below). 

 Three or more beam or joist members are on the same horizontal plane. 
 

7.4.2 Levels exported from Tekla Structures 

For Tekla Structures, only levels containing a part grip point node will be exported. Where level entities have been 
generated but do not relate to any structural element they will be ignored for the purposes of integration. 
Please note that there are no realistic limits on either datum level names or grid references which can be assigned 
although we do recommend the use of clear and concise references. The integration process will allow the use of 
both alphanumeric Latin characters along with alternative symbols if these are required. 
 

 

These levels 
exported 
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7.5 Specifying objects within Tekla Structures. 

When objects are imported from Tekla Structures into Tekla Structural Designer, the style of the object is set to 
be a copy of the item in the BIM software (e.g. Beam instances will be created as beam objects, bracing instances 
as Brace items etc.). 
 
It is possible to override this though and stipulate the object style on import by setting text in the type field. The 
following text can be set within the parameters MEMBER_TYPE, SLAB_TYPE and WALL_TYPE which are available 
in the Tekla Structural Designer UDA sections for all members, slab and panel elements respectively. 
Setting this information forces the element to be imported as that style of object within Tekla Structural Designer. 
 
Some of the entries relating to Portal Frames cannot be imported into Tekla Structural Designer at present and 
are only included for list completion. 
 

MEMBER_TYPE parameter codes Description  

Columns 

SIMPLE_COLUMN Column with the simple design option checked 

GENERAL_COLUMN Column with the simple design option unchecked 

Beams and Braces 

COMP_BEAM Composite beam – No edge conditions set 

EDGE_COMPOSITE_BEAM Edge condition composite beam 

INT_COMPOSITE_BEAM Internal condition composite beam 

GENERAL_BEAM Beam member 

BRACE Bracing member 

JOIST USA joist member 

SB_CANTILEVER_A Cantilevered beam; free at start end 

SB_CANTILEVER_B Cantilevered beam; free at finish end 

GB_FREE_END_A General beam; free at start end 

GB_FREE_END_B General beam; free at finish end 

GB_FREE_BOTH_ENDS Multi-span general beam member 

WSTK_WESTOK Ribbon cut Westok beam 

WSTK_CANTILEVER_A Cantilevered Westok member; free at start end 

WSTK_CANTILEVER_B Cantilevered Westok member; free at finish end 

ANALYSIS Analysis element 

  



7 Generating efficient integration models 46 (50) 

 

Guidance Documentation Tekla Structural Designer 
© Trimble Solutions Corporation | [Date] Integration with Tekla Structures 

 

Truss Members 

INT_TRUSS Internal truss member 

SIDE_TRUSS Side truss member 

TOP_TRUSS Top chord of truss 

BOT_TRUSS Bottom chord of truss 

Portal Sections 

PORTAL_COLUMN Portal frame stanchion (export from Tekla Structural Designer only) 

PORTAL_RAFTER Portal frame rafter (export from Tekla Structural Designer only) 

PORTAL_TIE Portal frame tie member (export from Tekla Structural Designer only) 

GABLE_POST Gable post member 

EAVES_BEAM Eaves beam member 

RAIL Sheeting rail member 

PURLIN Purlin member 

PARAPET_POST Portal frame parapet post (export from Tekla Structural Designer only) 

 

WALL_TYPE parameter codes Description  

Shear Walls 

MESHED Shear wall using mesh analysis method 

MID_PIER Shear wall under mid-pier theory 

 

SLAB_TYPE parameter codes Description  

Slabs 

RC_SLAB Two way spanning slab on beams 

RC_SLAB_1WAY One way spanning slab on beams 

COMP_SLAB Composite slab 

FLAT_SLAB Flat slab 

CAST_SLAB Precast slab 

STEEL_DECK Two way spanning steel deck slab 

STEEL_DECK_1WAY One way spanning steel deck slab 

TIMBER_DECK Timber deck slab 

  



7 Generating efficient integration models 47 (50) 

 

Guidance Documentation Tekla Structural Designer 
© Trimble Solutions Corporation | [Date] Integration with Tekla Structures 

 

7.6 Beam End Forces 

Tekla Structures will import end forces for steel beam and bracing members. The forces imported will depend on 
the end condition applied to the element within Tekla Structural Designer. Where the force is not applicable (e.g. 
Moment forces on pinned member ends) the parameter will not be populated. 
For parameters to be populated, an analysis of the frame must have been performed within Tekla Structural 
Designer, the End forces option must have been enabled during the export process and the End forces option 
must have been enabled during the import process. 
Please note that forces are populated from the largest results across the full range of different combinations or 
loadcases and may not strictly act in unison. Please refer to detailed results from the Tekla Structural Designer 
software for values per combination or per loadcase. 

 
 

Parameter Name  Description of force on member end  Populated By 

Result_StartVShearMax Maximum positive vertical shear on end 1  All steel beam members 

Result_EndVShearMax Maximum positive vertical shear on end 2 All steel beam members 

Result_StartVShearMaxNeg Maximum negative vertical shear on end 1 All beams where applicable 

Result_EndVShearMaxNeg Maximum negative vertical shear on end 2 All beams where applicable 

Result_AxialMax Maximum positive or negative force carried Bracing members only 

Result_StartAxialMax Maximum positive axial force on end 1 Moment or fixed ends 

Result_EndAxialMax Maximum positive axial force on end 2 Moment or fixed ends 

Result_StartAxialMaxNeg Maximum negative axial force on end 1 Moment or fixed ends 

Result_EndAxialMaxNeg Maximum negative axial force on end 2 Moment or fixed ends 

Result_StartMomentMax Maximum positive moment on end 1 Moment or fixed ends 

Result_EndMomentMax Maximum positive moment on end 2 Moment or fixed ends 

Result_StartMomentMaxNeg Maximum negative moment on end 1 Moment or fixed ends 

Result_EndMomentMaxNeg Maximum negative moment on end 2 Moment or fixed ends 
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8 Information Transferred 

8.1 From Tekla Structures to Tekla Structural Designer  

8.1.1 Information Transferred 

The following information is transferred from Tekla Structures to Tekla Structural Designer : 
 

 All grid lines in Tekla Structures are imported. 

 All levels in Tekla Structures are imported as levels with floor and diaphragm flags not set. 

 By default supports are created at the bottom of every column unless another supporting element can be 
detected. 

 All selected Tekla Structures beams, columns and braces are imported, including curved beams. Their 
snap alignment position, orientation, material type, grade and section size will be maintained. In 
addition:- 

 Member releases at the ends of the physical members will be maintained. 

 US Bar Joists are handled. 

 Slanted columns are handled.  

 All selected Tekla Structures Slab members will be imported:- 

 Horizontal and sloping slabs will be imported as slabs covering the same area. If holes exist in the Tekla 
Structures panel, they will be ignored. 

 Slabs in Tekla Structures without concrete plank or decking information will be transferred but with 
generic information. 

 Slab with a metal deck layer or the appropriate shared parameter will be defined as composite slabs with 
the relevant decking. 

 Slabs with concrete plank shared parameters will be defined as composite slabs with the relevant pre-cast 
concrete plank. 

 All selected Tekla Structures panels will be transferred if they are linear: 

 If holes exist in a Tekla Structures panel, they will be ignored for the purposes of integration. 
 

8.1.2 Limitations 

The following limitations exist in the current release : 
 

 No Westok members are exported – however existing Tekla Structural Designer information will be 
retained on synchronising models. 

 No Rebar objects will be transferred. 

 No pre-cast concrete beams or columns will be transferred. 

 No web openings and stiffeners will be transferred. 

 Portal Frame members will not be exported to Tekla Structural Designer.  
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8.2 From Tekla Structural Designer to Tekla Structures 

8.2.1 Information Transferred 

The following information is transferred from Tekla Structural Designer to Tekla Structures : 
 

 All grid lines in Tekla Structural Designer are exported. 

 All construction levels are exported if flagged as Floor. 

 All columns of all materials are exported along with all rotations. For concrete filled columns, an user 
attribute of concrete grade is set up. 

 All beams are exported along with all rotation and end release information. 

 For Composite Beams, the standard Tekla parameters “Camber Size” and “Number of Studs” are set up 
and an additional parameter for the Transverse Reinforcement. 

 If a beam changes size along its length in Tekla Structural Designer, it will be split into separate physical 
members. 

 US Steel Joists are exported along with all rotation and end release information. 

 All Truss Members are exported along with all rotation and end release information. 

 Braces are exported. 

 Portal Frames are exported as separate members but due to limitations, haunches are not exported and 
the physical positions of various members will need to be adjusted. As a result, it is not possible to export 
such members back to Tekla Structural Designer. 

 Slabs are exported with metal deck or concrete plank information as appropriate – where possible, metal 
decks will be represented physically, where not possible they will be represented by shared parameters. 

 Shear Walls are exported. 

 It is worth noting that members which are set to Auto-design and thus have no size are sent to Tekla 
Structures as a special UB. 

 

8.2.2 Limitations 

The following limitations exist in the current release : 
 

 No curved walls or warped structural concrete slabs will be transferred. 

 No walls which incline in elevation will be transferred. 

 No wind walls are exported. 

 No roofs are exported. 

 No connection information is exported. 

 No curved gridlines are imported. A straight grid is introduced instead. 

 No cold formed sections are created. 

 Bison Planks cannot be modelled physically in Tekla Structures, but information is available through 
shared parameters. 
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8.3 Tekla Structural Designer information retained during Round Tripping 

The following information is not transferred but once created in Tekla Structural Designer maintained during 
Round Tripping :- 
 

 Floor settings for diaphragms, imposed load reduction settings. 

 Column information including :- 
o design criteria. 
o releases.  
o restraints and effective lengths. 
o notional eccentricities. 

 Beam information including :- 
o design criteria. 
o support types.  
o restraints and effective lengths. 
o floor construction. 
o effective widths. 
o stud layout. 

 Westok data not modelled in Tekla Structures. 

 Brace information including:- 
o connection type. 
o analysis attributes. 
o tension/compression design attributes. 

 Support data at the base of columns only. 

 Loading and combinations including all Wind Data. 

 Roof and Wall positions and attributes. 

 Analysis and design options. 

 List of Frames. 

 Selection Groups. 
 
 
Please note that on a model merge in Tekla Structural Designer currently :- 

 All design results are lost and design will need to be repeated. 

 All previous connection design is lost and needs to be repeated. 


